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Session one ï Scalextric4Schools challenge 

Introduction 

The Scalexstric4Schools challenge is a curriculum project where you will be taught how to 
use Pro|ENGINEER 3D parametric modeling software to create a 1:32 scale racing car.   

After studying the physics of car performance you have the knowledge and understanding 
to redesign your car before manufacturing and testing it. 

A series of competitions are planned giving you the opportunity to race your car against 
those designed by students from other schools.  

 

Prior learning 

This module assumes you are already familiar with Pro|ENGINEER and comfortable 
creating parts, assemblies and testing movement using kinematic motion. 

If you are not confident about these techniques you should complete the Cam toy or Wind 
sculpture modules prior to attempting this one. 

Teachers who complete accredited training are given access to PTC University Coach, a 
virtual learning environment with 100s of hours of self paced tutorials covering all of the 
tools and techniques available in Pro|ENGINEER.  Teachers should contact their trainer 
for details. 

 

Scalextric4Schools curriculum 

This is a partnership between PTCÊ, HornbyÊ 
and Penske RacingÊ. 

Rules for the Formula 3 challenge are posted on 
the challenge web site at:  
www.scalextric4schools.us  

The activity was originally developed by design 
&\technology teachers at Edgecliff High School in 
Staffordshire, England.  The cars you see on the 
right and below were created at the school. 

http://www.edgecliff.staffs.sch.uk/  

 

 

 

Scale models 

Most slot cars are designed to scale of 1:32.  This 
means a car 12 feet long in real life will be 4.5 
inches long to this scale.  Later in this tutorial you 
will be shown how to transfer your sketches into 
Pro|ENGINEER and trace around them to create 
the shape of your car. 

 

http://www.scalextric4schools.us/
http://www.edgecliff.staffs.sch.uk/
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Challenge 

You are invited to design and make a slot car 
based around a standard design chassis.  Models 
should be to a scale of 1:32 and comply with the 
rules in Appendix one. 

 

 

 

After designing and making your car you will be able to test it on any Scalextric track, as 
will even work on old track which many homes have stored away.  Online auction sites are 
another source of second hand or new Scalextric. 

Schools can buy sets of parts and a special track layout for this challenge at heavily 
discounted prices.  Visit the challenge web site at: www.scalextric4schools.us  

 

 

 

Car design 

The slot car body will be vacuum 
formed from thin thermoplastic 
sheet over a 3D former. 

 

 

 

Schools may have access to other 
manufacturing methods including 
Rapid Prototyping. 

This body shell was produced on a 
Dimension 3D printer in ABS plastic. 

http://www.dimensionprinting.com/  

 
 

 

http://www.scalextric4schools.us/
http://www.dimensionprinting.com/
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Your task will be to create a design 
for the body around a standard 
chassis using Pro|ENGINEER.   

After modeling the design you will 
manufacture, assemble and test it.   

  

 

 

Thermo-plastics 

Thermoplastics become soft when heated. 
They can be molded and remolded easily 
making them ideal for school projects. 

Thermoplastics consist of long molecular 
chains with hardly any regular structure. 

There are many thermoplastics available 
including; acetal, acrylic, nylon, 
polycarbonate, polyethylene, polystyrene. 

 
 

http://en.wikipedia.org/  

 

Outline 

In this section you will be taught how to use 
the 3D solid modeling tools in 
Pro|ENGINEER to create a model slot car. 

 

The starting point is a part with half the 
base modeled and wheel arch cutouts.   

  

 

You will open the part, suppress the wheel 
arch features then model the shape of a 
saloon car on the base. 

With symmetrical designs it is good practice 
to model half and mirror the entire part.  
This cuts down the number and complexity 
of features, preserves symmetry and makes 
it easier to change the design later. 

Any asymmetric details like driver steering 
wheel, windshield wipers, tail pipes, etc are 
modeled after the mirror feature.  

 

 

http://en.wikipedia.org/
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Task one - Prepare for modeling 

1. Visit the challenge web site at www.scalextric4schools.us and go to the Parts tab 
and download the parts zip file. 

2. Create a folder in youôre My Document/network user area for your car design. 

3. Unzip the parts to the folder you just created. 

4. Start Pro|ENGINEER  

5. In the Navigator (down the left-hand 
side of Pro|ENGINEER) and Browser 
Windows, locate your design folder.  

If the Navigator is not displaying Folders left-

click the Folder tab  at the top of the 
Navigator Window.  

 

 

6. Right-click your design folder in the 
browser window and select Set 
Working Directory. 

 

 

7. In the Navigator window click on  
Working directory and the sample 
Open your design folder and double 
click the part named 
BODY_MOLD.PRT 

In the Navigator panel on the left of the 
Pro|ENGINEER screen you will see the 
model tree showing how this part has been 
constructed.   

It will be easier to model the body if we 
suppress the features that create the wheel 
arches. 

 

 

 

 

8. In the model tree drag the  
Insert Here flag up until it is 
underneath BASE-CORNERS 

The model tree will look like this and the 
wheel arches will disappear from the model.  

 

 

http://www.scalextric4schools.us/
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Notice the small black squares next to some of the features in the model tree?  These 
indicate the features are ósuppressedô and not being shown in the model. 

 

Task two ï Body profile 

Overview 

The body profile will be drawn on an external sketch located on the FRONT datum plane.  
The sketched profile is referenced to, and above the TOP datum plane with additional 
references created at the two ends of the base extrusion.  

 

 

 

9. In the Features toolbar on the right of 

the screen click on  the Extrusion 
tool. 

The Extrusion dashboard will appear across 
the top of the modeling window. 

10. In the Dashboard click on Placement. 

11. In the modeling window select the 
FRONT datum plane for sketching and 

then click . 
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Adding references 

To locate the sketch accurately we must 
know exactly where the ends of the base 
are.  We can do this by adding sketch 
óreferencesô. 

12. In the top toolbar click on the Sketch 
pull-down text menu then select 
References. 

The sketch references dialog opens on the 
right of the screen. 

13. Zoom into one end of the base 
extrusion. 

14. Click on the vertical end of the base. 

 

 

 

A dashed brown line will appear and a new 
entry will be added to the Sketch references 
dialog. 

15. Repeat the process to create a sketch 
reference at the other end of the base 
extrusion. 

16. In the References dialog click Close. 

 

 

Sketching the body profile 

17. In the Sketcher toolbar select  the line draw tool. 

18. Draw the shape shown here clicking at each X starting with number one and finishing 
back at the same point. 

 

 

19. When you finish drawing the shape double click the middle mouse button. 

Your sketch should look like this with dimensional constraints.  Your dimensions may not 
be exactly the same as these. 
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Pro|ENGINEER has added dimensions (colored grey to show they are óweakô).  We want 
to specify some of the dimensions and change their values. 

 

Sketch diagnostics 

Before we do that we should check the sketch is a valid profile and will extrude 
successfully. 

Pro|ENGINEER has tools to help check 
whether a sketch is a valid profile. 

20. In the Sketch menu click on 
Diagnostics and Select Shade Closed 
Loops.  

 

 

The sketch will now be 
shown shaded to show it is 
a valid profile for extruding 
later. 

 

 

 

If your sketch does not shade in you will need to find out why.  The most likely reasons 
are: 

Cause Cure 

¶ Gaps - Lines that do not 
meet properly 

Zoom in on each intersection to find the gap then delete 
one of the lines and redraw it making sure the new line 
attaches at both ends. 

¶ Coincident lines - Lines 
drawn on top of each 
other 

Select a line and delete it.   

If the line is still visible delete it again. 

Repeat until the line is no longer visible then undo. 

¶ Extended lines  Zoom in on each intersection looking for a line that goes 
too far.  Use the trim tool to delete the extended part of 
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the line. 

¶ Stray lines Look around and inside the profile to look for small 
unconnected lines. 

 

If these techniques do not work you may have to delete all the lines and sketch the profile 
again. 

 

Revising the dimensioning scheme 

You will alter some of the existing dimensions and create new ones to take control of the 
sketch lines and shapes. 

Note: 

There are 3 types of sketch dimension; 

¶ Weak  - these are colored gray and created by Pro|ENGINEER automatically.  They 
report sizes in the sketch but allow changes to be made including letting you drag 
lines and points. 

¶ Strong ï these dimension are white in color.  Geometry controlled by Strong 
dimensions can be dragged on screen. 

¶ Locked ï these dimensions are orange in color.  Geometry controlled by locked 
dimensions cannot be changed by dragging on screen.  Locked dimension can are 
changed by double clicking and retyping a different value. 

 

Adding a dimension. 

This is straightforward and involves left clicking on the extents of the dimension then 
middle clicking to locate the dimension text. 

21. Zoom in on one end of the car profile. 

22. In the sketcher toolbar on the right of 

the screen, select  the Create 
Defining Dimension tool. 

23. Move the mouse over the vertical 
reference line X1 and left click to 
select. 

24. Move the mouse cursor over the end 
point of the base line X2 then left click 
to select. 

25. Move the mouse cursor to where you 
want the dimension text to be placed 
then middle mouse click X3. 
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Changing a dimension 

26. In the sketcher toolbar click  to 
activate the Select tool 

27. Double click on the dimension text X1  
just created. 

28. Type in 2 then press Enter on the 
keyboard. 

Notice the dimension is orange in color 
denoting it is locked.  Also notice the weak 
dimension has now disappeared.   

This is a major strength of Pro|ENGINEER, 
it constantly manages dimensions to fully 
specify the sketch. 

 

 

29. Create another 2mm dimension at the opposite end of the sketch. 

 

 

Adding other dimensions 

There are two other types of dimension you may want to create. 

Line length 

30. In the Sketcher tool bar activate  
the Create Defining Dimension tool.  

31. Left click on one of the lines in the car 
profile X1.  

32. Move the mouse cursor to one side of 
the line and middle mouse click X2 to 
locate the dimension text.  

33. With the Select tool  active, double 
click on the dimension text, change it 
to the nearest whole number then 
press Enter on the keyboard. 
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Angle dimension 

34. In the Sketcher tool bar activate  
the Create Defining Dimension tool.  

35. Left click on one of the lines in the car 
profile X1.  

36. Left click on the adjacent line in the car 
profile X2.  

37. Move the mouse cursor to one side of 
the lines and middle mouse click X3 to 
locate the dimension text. 

38. With the Select tool  active, double 
click on the dimension text, type in a 
new value rounded to the nearest 5 
degrees then press Enter on the 
keyboard. 

 

 

Drag to change shape 

39. In the Sketcher toolbar activate  the Create Defining Dimension tool. 

40. Click to select one of the connections between the lines then click and drag to 
reposition the point.   The shape should change shape as you drag.  If the shape 
suddenly changes shape use the undo button. 

 

Fully constrained sketch 

Engineers are very careful people and do not like anything left to chance!   They would 
add dimensions to the sketch until there were no gray, weak dimensions.  The illustration 
below has been fully constrained in this way with all the dimensions locked (orange). 

 

 

41. Once you are happy with your sketched shape, check it is still shaded and there is a 
horizontal constraint H on the roof. 

42. On the right of the screen, in the sketcher toolbar click on  to close sketcher. 
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The design window will change to a shaded background and the feature toolbar replaces 
the sketcher toolbar on the right of the Pro|ENGINEER window. 

43. In the main toolbar click on  to 
open the saved views list and select 
Trimetric. 

 

 

This shape can now be extruded. 

44. In the feature toolbar select  the extrude tool. 

The extrude dashboard opens along the top of the graphics window. 

45. Change the options to those shown here. 

 

 

46. In the graphics window select the long 
thin surface of the base extrusion. 

47. The solid shape will preview in a 
yellow color. 

48. In the dashboard click on  to 
complete the extrusion. 

 

A new Extrude entry will appear in the 
model tree and the body will display as 
shown on the right. 
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Task three ï Side taper 

Outline 

The top half of the car needs to be tapered. 

This will be done by drawing a diagonal line 
on the RIGHT datum plane referenced to 
the side, roof and bonnet line of the car. 

The sketch will be extruded symmetrical 
about the sketch and óThrough allô in both 
directions.  

 

 

Note: The following screen captures have a white background for clarity on paper.  Your 
screen background will be black while working in sketcher. 

 

Cut sketch 

1. In the feature creation toolbar, click on 

 to start a New Sketch. 

2. In the model tree, select the RIGHT 
datum plane. 

3. Either, click on Sketch or middle 
mouse click to close the sketch dialog. 

4. You will enter sketcher and the model 
will rotate to view from the front of the 
model. 
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Create sketch references 

5. In the Main toolbar click on the Sketch 
pull down text menu and select 
References. 

6. The Sketch References dialog opens. 

7. Click on the top X1 and left vertical 
sides X2 of the body to create 
references. 

Orange dashed lines will appear along the 
selected geometry and new entries will be 
added to the list in the references dialog. 

 

 

8. Right click on the edge across the front 
of the car at the top of the bonnet X1.   

A surface will pre-highlight and the prompt 

line will report:  

9. Right click again and an edge will pre-
highlight and the prompt line will now 

report: . 

 

 

10. In the sketcher toolbar, click on  to 
activate the Line draw tool. 

11. Draw the diagonal line shown here 
making sure the ends snap to 
reference lines. 

12. Add an angle dimension and change it 
to 20 degrees. 

 

 

13. Click on  to finish sketching. 

14. In the Main toolbar click on  then 
select Trimetric view. 

15. In the feature toolbar on the right of the 

screen select   extrude. 

16. In the dashboard change the choices 
to those shown below. 
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17. In the dashboard click Options to 
open the drop-down panel. 

18. Change both sides to Through All. 

 

 

 

19. Click on  to complete the Extrude 
feature. 

 

The side of the car body will now be 
tapered. 
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Task four ï Rounds 

1. In the Feature toolbar on the right of the 

screen select  the Round tool. 

2. Click to select the edge shown here in 
red. 

3. In the dashboard change the radius to 
30 mm, press Enter on the keyboard, 

and then click on  to complete the 
round feature. 

 

 

 

4. Start a new Round feature, select the 
edges shown here and set the radius to 
5 mm. 

5. Click on  to complete the round 
feature. 

 

 

 

 

6. Add a new Round of 5 mm radius to the 
edge show here. 

 

Notice how Pro|ENGINEER joins up all the 
edges that are tangential?  

 

 

 

Task five ï Complete the mold 

To complete the mold you need to add a 
round on the corners and mirror the shape. 

1. Add a Round feature of 5 mm radius to 
the corners shown. 
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2. Make datum planes visible. 

3. In the model tree click on the top entry 
BODY_MOLD.PRT to select it. 

4. On the right of the screen, in the 

Feature toolbar, select  the Mirror 
tool. 

5. Either in the model tree or in the 
graphics window select the FRONT 
datum plane as the mirror axis. 

6. Click on  to complete the mirror 
feature. 

7. Save the model. 

 

 

The purpose of the part you have created is to generate manufacturing tool paths so the 
appearance is not important.  If you would like to apply a surface texture such as a wood 
finish, detailed instructions are in the CO2 Car/ F1 in Schools tutorials. 

 

Homework one - Design guide 

Read through the Design guide section of the Reader for this project.  You will need an 
understanding of car performance for the next session session. 

 

Session two ï Physics of car performance 

Task one - Review homework. 

At the start of the session your teacher will help the group collate key factors affecting car 
performance.  These will be used later to help re-designing your car. 

 

Task one - Create an STL file for machining 

The most common file format used to transfer 3D shapes to machining software is STL.   

Here you will be show how to export an STL file of your model. 

The accompanying reader document contains a full description of the STL file format and 
machining. 
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1. Open the File pull-down menu and select Save a Copy. 

2. Change the Type option to STL (*.stl). 

3. Accept the default filename or type in a new one. 

4. Click on OK to close the dialog. 

5. A new Export STL dialog will open. 

6. Change the Chord Height value to 0 (zero). 

7. Pro|ENGINEER will enter the smallest practical value 
for Chord Height. 

8. Change the Angle Control value to 1 

9. Click On OK to close the dialog and the STL file will be 
created in the working directory 

The model will be updated to display the STL surface.  You 
may not be able to see any difference. 

 

 

10. Zoom in to a curved corner and you will 
see the triangular surfaces created by 
the STL conversion. 

11. Click on  to repaint the screen and 
return to the parametric model. 

Note: A fuller description of the machining 
process can be found in the accompanying 
Reader document. 

 

 

 

Task two ï Review design factors 

In design teams you will summarize your investigations creating a set of bullet points to 
guide design development. 

 

Competitions 

If you intend to enter one of the Scalextric4Schools competitions you will need to work 
within the regulations that can be found on the www.scalextric4schools.us  

You will now be shown how to convert a paper sketch into a 3D CAD model, then how to 
make changes to existing parts and finally alternative 3D modeling features. 

 

Homework two ï Design sketches 

Sketching 

Sketching skills are vitally important when designing to communicate your ideas and 
thoughts to others.  As you have seen, your body design must accommodate the standard 
chassis and internal components.  

http://www.scalextric4schools.us/
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The starting point for the CAD modeling you 
have just carried used a part called 
BODY_MOLD.PRT 

The shape was based on a saloon car to a 
scale of 1:32.  This is the same scale as 
Scalextric cars and track. 

The base feature covers the 2mm acrylic 
chassis component while the wheel arches 
provide clearance around the wheels and 
axles. 

 

A number of other components in the 
assembly protrude and these need to be 
enclosed inside your car body. 

 

Your teacher will provide you with copies of 
the template (Appendix three). 

 

 

 

 

 

¶ Sketch your ideas on the template in the appendices (do not use the diagrams 
above as they are not to scale).  Your teacher will give you copies for this.   

¶ At all stages check your designs conform to the competition rules. 

¶ Bring your design sketches to future lessons. 

 

Homework two ï Hornby the company 

Read through the óHornby the companyô section of the Reader for this project.   

You will be asked questions on this at the start of the next session. 

 

Session three ï Modify Pro|ENGINEER models 

Outline 

During this session you will learn how to modify existing designs, correct some of the faults 
that can occur and hear about other 3D modeling tools.    

But firsté 
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Task one ï Hornby the company 

Your teacher ask to class to show their knowledge of Hornby, one of the foremost 
manufacturers of slot cars in the world. 

 

Task two ï Modify an existing part  

A key strength of 3D parametric modeling is the ability to make changes to a model.  The 
model tree provides access to datum, sketches, features and other information used to 
create the part. 

 

Edit or Edit Definition? 

Right clicking on an entry in the model tree opens a floating menu.  Among the options will 
be Edit and Edit Definition.   

The Edit option gives you immediate access to dimensions within the part or assembly.   

More complex changes to lines, geometry or feature options can be made using the Edit 
Definition option. 

 

Edit 

Edit allows the designer to make changes to 
dimensional constraints very quickly. 

 

1. Open the part named SPOKES.PRT 

 

This is part of the wheel sub assembly and 
will be used to demonstrate how to make 
changes to the model. 

 

 

 

2. In the model tree, click on the + next to 
the entry for Pattern 1 of Hole 1 and 
the + next to the extrude REMOVE to 
show the internal sketch. 

This will show the feature and sketch used 
to create the pattern. 

3. Move the mouse cursor over the sketch 
named S2D0002 in the list and right 
mouse click. 

4. From the floating menu select Edit. 
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The dimensions used to create the sketch 
will display on the model in the graphics 
window. 

5. Double click on the dimension for the 
hole diameter to activate it, change the 
value to 5mm then press ENTER on the 
keyboard to confirm the change. 

6. In the Main toolbar click on  to 
Regenerate the model. 

 

 

 

 

 

 

You will see the effect of the change in the 
model. 

 

 

Edit Definition 

Edit Definition gives the designer access to 
all the options used to create an entry in the 
model tree. 

 

7. The modified part named SPOKES.PRT 
should still be open on screen 
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In the model tree, the sketch used to define 
the shape of the removed material should 
still be visible. 

8. Move the mouse cursor over the sketch 
named S2D0002 in the list and right 
mouse click. 

9. From the floating menu this time select  
Edit Definition. 

 

 

 

The sketch will open with the sketch toolbar 
on the right of the screen. 

10. Make the changes you want to the 
sketch. 

Here we have created a lobed sketch  

11. Click on  in the sketcher toolbar to 
confirm the change and close sketcher. 

 
 

 

 

You will see the effect of the change in the 
model.  

Note:  changes made using Edit Definition 
automatically regenerate the model. 

Tip: Before making major changes to 
geometry it is useful to suppress the 
features below.  After making the changes 
each feature can be resumed to isolate and 
correct any parent/child failures. 

 

 

 

Parent/child relationships 

This is nothing to do with who looks after you at home!   

The model tree in Pro|ENGINEER lists all the steps taken in creating a model.  Entries in 
the model tree build up chronologically but are also likely to óreferenceô or rely on previous 
entries.  This is called óParent/childô relationships. 
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You should expect modeling failures when modifying designs and learn how to edit the 
model tree to correct the faults. 

 

Task three - Dealing with failed features 

This example shows changes to the body profile.  Read through this so that you will know 
what is happening when failures occur. 

Two lines for the windscreen and bonnet have been replaced with a single line to create a 
van shape.   

 

Before After 

  

 

Lower down the model tree a round relies 
on four edges running across the body. 

The round is óchildô to the four óparentô 
edges. Changes to the profile sketch have 
removed one of the parent edges so the 
round will fail when Pro|ENGINEER 
regenerates the model. 

The failure will be reported like this.  
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The good news is, these failures are 
easily fixed.  Menu manger at the 
right of the screen provides the tools 
to suppress or correct the failure. 

Here, Quick Fix > Redefine > 
Confirm provides access to the 
failed round feature.   

 

 

 

 

Opening the Sets pop-up panel in the round 
dashboard reveals the missing edge in the list of 
References, shown with a small yellow dot.   

Right clicking on the edge entry and choosing 
Remove corrects the failure. 

 

 

After closing the round dashboard, a final confirmation menu 
appears.  Clicking yes completes the process of correcting the 
fault. 

 

 

 

Note:  Making changes to complex models may generate several failures.  Each failure 
must be suppressed or corrected before continuing. 

 

Task Four - Reverting to a previous version of a part 

We probably donôt need to mention the importance of saving your work regularly! 

When a part or assembly is created in Pro|ENGINEER 
a number is added after the file name and file extension. 

Each time you save the part or assembly a new file is 
created with the number incremented.  Here is an 
example where the base part was saved sixteen times 
during development. 

If changes to a model go seriously wrong you can close 
the part, erase the model from memory and then open a  
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previous version of the part. 

1. In the Navigator panel click 
on the Folder Browser tab. 

2. In the Folder Browser 
window click the Type list 
and choose Part (*.prt) 

3. Open the Tools list and 
select All Versions option 

then click on . 

You will now be able to see all 
the versions of each file. 

4. Click on one of the earlier 
versions and open the 
Preview panel at the 
bottom of the browser 
window. 

5. The earlier part version of 
the part will preview.  

 

 

Homework three ï Competition rules 

¶ Take a copy of the competition rules home with you.   

¶ Read through them carefully.   

¶ Read through again looking for opportunities to design a car that will be quick 
around the track.   

¶ Write down a list of the top five things you think will make a car quick.  Bring the list 
with you to the start of the next lesson. 

You now have the knowledge to design your own car.   

 

Extension one - Alternative modeling strategies 

If you found the Pro|ENGINEER  modeling so far easy, you may want to know about a few 
other 3D features and modeling strategies that could be used to create a car body.  Some 
of these are summarized next. 

Pro|ENGINEER contains many different modeling tools, many of which could be used to 
create elements of the body design.  Below are examples of car bodies created using 
different modeling strategies. 

 



Pro|ENGINEER Wildfire 4  Scalextric4Schools 

PTC ï www.ptc.com www.scalextric4schools.us page 29 of 60 

Swept blend 

Experienced users of Pro|DESKTOP will 
recognize this as a Loft. 

A series of sketches define sections through 
the shape. 

In addition to the profile sketches, 
Pro|ENGINEER needs a line to show the 
trajectory or direction for the swept blend.  
Here the trajectory is shown in red with a 
yellow arrow indicating the starting point 
and direction for the swept blend.  

The model tree for a swept blend car body is shown here.  It 
is made up of a trajectory sketch and five parallel profile 
sketches. 

One of the profile sketches is located on the RIGHT datum 
plane and the others on the four new datum planes DTM1 ï 
DTM4. 

The trajectory sketch was created on the TOP datum plane. 

Note: The first and last profile sketches must be positioned 
at the ends of the trajectory line.  

With all the geometry needed for the swept blend in place 
the swept blend feature was created.  

The swept blend dashboard looks like this. 

 

 

 

 

Note: Swept blend defaults to 

creating a surface so  the 
Create Solid button has been 
selected. 

 

The Trajectory is stored in the 
References pop-up panel. 
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Although profile sketches can be 
created after starting the Swept 
Blend feature, in this example the 
sketches were created first so the 
top option was changed to 
Selected Sections. 

Sketches were added to the list of 

sections by clicking  each 
time. 

 

 

Once all the options had been 
chosen, the model looks like this. 

Clicking on  in the dashboard 
completes the feature. 

Tip:  If the green tick/check mark 
is grayed out, selections in the 
dashboard are not complete.  
Look in the message area of the 
screen for feedback on what 
Pro|ENGINEER is expecting you 
to do.  

 

 

Variable section sweep 

This very powerful modeling feature uses a cross section sketch that runs along one or 
more control curves to create a variable cross-section surface or solid. 

Here there are four control curves; 

¶ Origin - a straight line under 
the centre of the car defining 
the direction 

¶ Chain 1&2 - two straight lines 
either side defining the width of 
the section 

¶ Chain 3 - a curved spline 
defining the top  
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The model tree for a variable section sweep is shown here.  
It is made up of a trajectory sketch a side profile sketch and 
a roof profile sketch,  

The trajectory and side profile sketches are located on the 
TOP datum plane and the Roof profile sketch is located on 
the FRONT datum plane. 

Note: DTM1 and DTM2 are used to locate the ends of the 
variable section sweep 2mm inside the base. 

Note: The cross section sketch does not appear in the 
model tree.  It is created within the variable section sweep 
dashboard. 

The variable section sweep dashboard looks like this:  
 

 

 

 

Note: Variable section sweep defaults 

to creating a surface so  the Create 
Solid button has been selected. 

The section sketch is defined by 

clicking on  in the dashboard. 

When creating the section sketch is 
very important to attach the sketch to 
the ends of the trajectory and profile 
sketches.  Pro|ENGINEER helps by 
snapping sketch lines to profile 
sketches. 

 
 

 

Once all the options had been chosen 
the model looks like this. 

Clicking on  in the dashboard 
completes the feature. 

Tip:  If the green tick/check mark is 
grayed out, selections in the dashboard 
are not complete.  Look in the message 
area of the screen for feedback on what 
Pro|ENGINEER is expecting you to do. 

 

 

Tip: Variable section sweep is very powerful but can fail particularly when asked to make 
very sudden changes in section. 
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PTC Curriculum ï Another curriculum project that uses the variable section sweep is the 
RP Car. 

PTC University Coach ï For more examples plus hands-on practice on variable section 
sweeps look on PTC University CADtrain Coach in the Online courses >Advanced 
Modeling section at: http://schools.ptculms.com/  

 

Note: Teachers can set up an account on Coach and request permission for their students 
to login to access the learning materials  

 

Warp 

The warp feature is a collection of tools that allow existing shapes to be squashed, bent 
and twisted in a very óorganicô way.  There are no sketches involved; instead, frames 
surround the affected area while points and edges on a mesh are pushed and pulled to 
change the model. 

These two images show the model before and after a warp feature is applied. 

 

 

 

Before After 

 

 

 

The warp feature is a single entry in the model tree but does 
rely on there being 3D shapes to act on. 

 

 

 

 

 

The Warp dashboard looks like this. 

http://schools.ptculms.com/
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Initial selections expect you to identify the solid 
the warp will be acting on, and the direction the 
warp will be applied. 

The direction is often a datum plane located 
perpendicular to the intended direction for the 
warp. 

These initial selections are stored in the 
óReferencesô pop-upô panel. 

 

 

 

The pop-up panel óListô stores each warp that is 
applied to the model. 

 

In this example two warps are listed.  

 

 

 

The first warp modifies the side profile of the 
block acting on the top surface of the model. 
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The second warp curves the side of the car 

body and uses , the symmetric option so that 
it is applied to both sides of the model. 

 

 
 

 

Tip: Warp is a very dynamic tool but can disturb previous 
geometry such as flat surfaces and cylinders.  If this happens 
create a cut after the warp to re-establish the geometric surfaces. 

Here the shell (covered later in this tutorial) would not allow the 
underneath surface to be selected as an opening.  To overcome 
this, Extrude 7 was inserted in the model tree to trim the wheel 
arch extensions and create a flat surface under the car.  These 
could then be selected as openings when creating the shell 
feature. 

 

 
 

 

 

PTC Curriculum 

The Teachersô Portal contains many more tutorials.  Your teacher can access these and 
make them available to you:  

https://pds.ptc.com/Windchill/netmarkets/jsp/project/view.jsp?oid=project~wt.projmgmt.ad
min.Project2%3A183631245&u8=1  

 

https://pds.ptc.com/Windchill/netmarkets/jsp/project/view.jsp?oid=project~wt.projmgmt.admin.Project2%3A183631245&u8=1
https://pds.ptc.com/Windchill/netmarkets/jsp/project/view.jsp?oid=project~wt.projmgmt.admin.Project2%3A183631245&u8=1
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PTC University Coach 

Your teacher can access multi-media tutorials covering all the features in Pro|ENGINEER 
at: http://schools.ptculms.com/  

 

 

Homework ï Change request 

When a commercial product requires modifying the design team agrees a change request.  
This looks a bit like a product specification and lists the changes needed. 

Create a óchange requestô listing the modifications needed to change the standard car 
body design to match your revised design.  Tip:  Use the model tree to order your list of 
changes.  

You will need your change request in the next session. 

 

Session four - Own Design 

You now have sufficient experience to model your own body.  However you may find the 
following design guidance helpful 

 

From previous homework 
you should have several 
sketch ideas for car shapes 
drawn on templates.   

 

  

 

You should also have a óchange requestô list of modifications to make. 

Your teacher will help you make the changes to create your own design of car. 

 

Extension two - Tracing a hand drawn sketch 

Tracing an existing product as a starting point is a technique often used in design including 
designers at Scalextric (Hornby).  This is very straightforward using Pro|ENGINEER. 

 

Scanning your drawings 

1. Choose one of your design sketches.  

2. Add the dimensions shown below to your drawing. 

3. Use a scanner to capture your drawings into the computer.  Create two tightly 
cropped images of the areas shown below as dotted red rectangles. 

http://schools.ptculms.com/
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Name the files Sketch-side.jpg and Sketch-front.jpg 

 

Schools Edition 

Using the Schools Edition of Pro|ENGINEER you can trace over a scale drawing.  The 
notes that follow are based on work done by Dave Cheshire at Staffordshire University.  
He produced a datasheet titled ñCreating a trace sketch without Styleò explaining how to 
do this and kindly allowed us to make this available on: www.scalextric4schools.us  

Dave Cheshire has created tutorials for many of the features in Pro|ENGINEER and 
schools can purchase these at:  http://www.cdcweb.co.uk/  

 

4. Make a copy of the part body-
mould.prt with a new name. 

5. Open the new file. 

6. Drag the finish flag up to below the 
DEFAULT_CSYS 

 

 

 

7. Create a sketch  on the FRONT 
datum plane 

8. Draw a rectangle and dimension it like 
this using the values from your sketch. 

9. In the sketcher toolbar click on  to 
close sketcher. 

 

 

http://www.scalextric4schools.us/
http://www.cdcweb.co.uk/
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10. The sketch you just created should be 
selected (colored red).  

11. Open the Edit pull-down menu and 
select Fillé 

The sketch should now be shaded to show 
it has been filled ï shown here in trimetric. 

 

12. Open the View pull-down menu and 
select Color and Appearance. 

13. In the Color and Appearance dialog, 
click on + to create a new material. 

14. Name the material Side-view. 

 

 

15. Select the Map tab then click on the 
square swatch button to the right of 
Color Texture.  

 

This will open a new Appearance Placement dialog. 

 

16. Click on + to create a new texture. 

17. Browse to and select the side view image you 
scanned - Sketch-side.jpg 

18. Make sure your sketch is selected and the 
Single radio button is also selected. 

19. Click OK to close the Appearance Placement 
dialog.   

 

The Appearance Editor dialog should still be open. 

20. Change the Assignment option to Surfaces. 

21. Click on the filled sketch. 

22. Click OK in the small dialog and a another small dialog will 
open  

23. Select Both to make the image visible on both sides of the 
filled sketch.  
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24. Click on the Apply button and you 
should see the image appear on the 
Front of the sketch surface.  

25. Before closing the dialog, select the 
Advanced tab and change the 
transparency slider to 50%.  

 

 

26. Open the File pull-down menu and 
select Save.  Accept the default name 
and click OK 

27. Now click Close. 

 

 

You may have wondered why we located the centre of the rear wheel over the intersection 
between the FRONT and RIGHT datum planes.   

This positions the sketch in the correct placement in relation to the rolling chassis. 

 

 

28. Repeat the process creating a filled 
sketch on the RIGHT datum plane and 
pasting your Sketch-front.jpg image 
on it. 

Remember the picture is automatically 
scaled to fit the original rectangle you drew 
so if the overall size, proportions or position 
are wrong just edit the dimensions of the 
sketch.  

 

Tracing with Schools Advanced Edition 

The Schools Advanced Edition of Pro|ENGINEER includes advanced surfacing tools.  
Two PTC DesignQuest tutorials explain how to do this; Deodorant bottle and Kettle.  
Both can be downloaded by teachers from the Teachersô Portal at: 

https://pds.ptc.com/Windchill/netmarkets/jsp/folder/list.jsp?oid=project~wt.projmgmt.admin.
Project2%3A183631245&u8=1 

 

https://pds.ptc.com/Windchill/netmarkets/jsp/folder/list.jsp?oid=project~wt.projmgmt.admin.Project2%3A183631245&u8=1
https://pds.ptc.com/Windchill/netmarkets/jsp/folder/list.jsp?oid=project~wt.projmgmt.admin.Project2%3A183631245&u8=1


Pro|ENGINEER Wildfire 4  Scalextric4Schools 

PTC ï www.ptc.com www.scalextric4schools.us page 39 of 60 

Homework four ï CNC machining 

Research CNC machining on the internet.  

Write a description of how: 

¶ A 3D CAD model is transferred to the machine tool computer 

¶ How the machine tool software creates instructions for the machine 

¶ How the machine removes material. 

¶ Advantages of CNC machining 

¶ Disadvantages of CNC machining 

 

Session five - Machining the mould 

Health & safety 

Before using any machinery, you must make sure you are properly trained and comply 
with all safety guidance and regulations. 

 

The machine most likely to be making 
the wooden mould for your slot car is a 
three-axis CNC router.   

For this to work your design must not 
have any undercuts that would prevent 
the molded body being removed from 
the former.  This tutorial has followed 
this rule. 

The diagram here shows the body half 
way through a roughing cut simulation 
in Boxfordôs 3D GeoCAM software. 

 

 

 

There are limitations to the detail that 
can be machined mainly associated 
with the diameter of the tool used for the 
final smoothing cut and the óstep overô 
(the distance between each cutter pass. 

 
  

 Large step over Small step over 

 

Manufacture 

The steps in turning your model on screen into a machined part are illustrated here. 

http://www.boxford.co.uk/
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There are two main ways to post process your model; 

¶ An STL file format and 3rd party software for your CNC machine. 

¶ The Pro|NC manufacturing module in Pro|ENGINEER. 

 

STL output 

This uses a file format created for 
the first rapid prototyping 
machines.   

Called Stereo Lithography the 
process builds models using a 
laser to harden layers of liquid 
resin. 

The file format uses the initial 
letters from the process i.e. .STL 

 

Image - http://en.wikipedia.org  

 

 

 

http://en.wikipedia.org/
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Converting the solid model into an STL file 
creates flat triangular surfaces all over the 
model. 

Pro|ENGINEER allows you to set 
parameters that define the size of the 
triangles.  A course mesh looks like this.  
The file will be small and post-processing 
the STL file into machine instructions will be 
quite quick.  The flat surfaces will be 
apparent on the machined shape. 

 

 

A fine mesh looks like this, the triangles 
creating a larger file size and taking longer 
to post-process into machine instructions. 

The small triangular surfaces are so small, 
they will be invisible on the machined 
shape.  

If a small diameter cutting tool is used for 
the finishing cut, a smoother surface will 
result. 

 

 

Session six - Vacuum forming 

The Technology Student web site has a very clear explanation of vacuum forming. 

http://www.technologystudent.com/equip1/vacform1.htm  

 

 

Machining 

The reader document for this project contains a detailed guide to using Boxford 
3DGeoCAM to post-process an STL file and simulate the entire machining process. 

http://www.boxford.co.uk/boxford/  

 

http://www.technologystudent.com/equip1/vacform1.htm
http://www.boxford.co.uk/boxford/
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Trimming the body molding 

 

 

After molding, the formed sheet will have 
surplus material that needs to be removed. 

 

 

 

This photograph shows how the body fits on 
to the chassis and where to trim off surplus 
sheet plastic. 

The easiest way to separate the car body 
form the formed sheet is using a óGerbilô 
trimmer.  Here the blade of a RJH machine 
is set to trim the body level with the bottom 
of the 3mm base. 
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Use a disk or belt sander to remove the 
wheel arch extensions opening up the 
wheel arches. 

 

Use fine abrasive paper to remove burrs 
and sharp edges. 

Here, abrasive paper is wrapped around a 
dowel to smooth the curve inside the wheel 
arches.  

 

 

Homework five ï Scalextric car design 

Would it be cool to spend your working day recreating the latest dream cars as Scalextric 
models?   Interested in how itôs done?  Then read the section in the reader document for 
this project. 

 

 

Session seven ï Testing, analysis & simulation 

Task one ï Designing model cars 

Your teacher will ask the class questions about the job of designing Scalextric cars.   

You should think of the disadvantages as well as good parts of this type of job. 
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In the past, designers and engineers would 
build real prototypes to test their designs.  
The results of testing were used to improve 
the design but the cost and time taken to 
build the designs meant the entire process 
lasted months or even years.  Testing could 
also be hazardous to the operator. 

This prototype was the forerunner of the 
Harrier /AV8B ójumpô jet.  The air intake 
ócuffsô are evidence of significant changes 
made as a result of testing and before 
production started.  There is famous footage 
of a harrier crashing at the Farnborough air 
show in front of large crowds. 

 

www.wikepedia.org 

 

A major advantage of computer 3D 
modeling is the ability to test and evaluate 
virtual designs. This cuts out the time and 
materials needed to make physical 
prototypes. 

Analysis tools in 3D modeling software are 
developing all the time and the following 
tests have been developed for your 
Scalextric car.  

 

Several simulations have been created based on the standard car model.  You will be 
shown how to interact with these, learning about the science and math of movement.  With 
this added understanding you will be in a better position to design a more efficient car. 

Advanced Pro|ENGINEER users will be able to interrogate the models and carry out the 
same tests on their own designs. 

 

Cornering 

The slot guide steers the front of the car round the corner while friction between the 
wheels and track stops the car sliding or spinning.  Two analyses have been provided for 
you to experiment with 

 

http://www.wikepedia.org/
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Location of centre of gravity 

1. Open your slot car design 

2. In the top toolbar open the Analysis pull-down 
text menu. 

3. Select Model then choose Mass Properties 

4. In the Mass properties dialog click on  to 
carry out an analysis.  Notice the Use default 
option is selected. 

5. Pro |ENGINEER will now report the centre of 
gravity in relation to the default coordinate 
system. 

 

 

6. Leave the dialog open and look at the model.   

Two coordinate systems will appear on the model.  
The default x,y,z coordinate system and one 
labeled 1,2,3.   

The second one shows the position of the centre of 
gravity for the car assembly. 

Try spinning the model to see where the c of g is.  It 
is likely to be in open space inside the car. 

 

 

You may want to check out some of the following items. 

Mass 

¶ Open a part. 

¶ Check material polystyrene ï find density. 

¶ Carry out mass measurement. 

¶ Change material to polyethylene ï check density. 

¶ Carry out another mass measurement. 

¶ Compare the results and densities between the two models. 

¶ What would be the effect of using one of the following materials? 

o Acetal, acrylic, nylon, polycarbonate. 

¶ You may need to look on the web for the densities of some of these materials. 

www.matweb.com  

 

Density 

¶ Find the density of a material by experiment 

http://www.matweb.com/
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¶ Predict the impact on performance of using the new material. 

¶ Make the changes to your model then take measurements of mass. 

¶ Interpret the results in terms of performance. 

¶ Use your conclusions to prompt further changes to your design. 

 

Impact of C of G on cornering 

Remember the cartoon earlier in this 
booklet showing a bus being tilted on a 
platform until it falls over?   

Here is the real thing. The test for buses 
was a 28 degree tilt.  All four tires must 
remain in contact with the platform at this 
angle.   

Notice the sloping wall to catch the bus 
should it begin to tilt. 

 
 

http://www.20thcenturylondon.org.uk/ 

An assembly has been created with the 
standard car óhingedô to the track by the 
edge of the tire.  Using the mechanism 
module in Pro|ENGINEER, gravity is 
applied and the track gradually tilted.   

When the force vector (arrow) showing 
gravity acting at the centre of gravity falls 
outside the wheelbase the model tips over.  

 

 

 

 

Design guide: Move heavy components as low as possible and reduce the overall height 
of the car as much as possible.     

 

Track 

Note: - This activity will be possible in Wildfire 5é! 

¶ Objects want to go straight on unless a force makes them change direction. 

¶ The slot provides a centripetal force on the slot guide making the car turn. 

¶ Interrogate slot mechanism connection. 

¶ Run Andyôs sim.  Car corners OK. 

¶ Increase power of motor. 

¶ Re-run sim and see car leave the tracké 

 

http://www.20thcenturylondon.org.uk/
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Design guide:  Tires with sharp edges are less likely to slide but may suddenly ódig inô 
making the car roll out of the slot.  A crashed car loses lots of time so competitors radius 
the edges of the rear tires to stop them digging in allowing the car to slide or drift around 
corners. 

 

Acceleration 

¶ Reminder of early summary 

¶ Run wheel spin simulation. 

 

Gearing 

¶ Interrogate gearing system and servo motor. 

¶ Change gearing ratio then re-run analysis. 

¶ What was the impact on acceleration? 

 

Design guide: Match gearing to each track.  For example low gearing for acceleration on 
tight, twisty circuits or high gearing for high speed circuits.   

Aim:  Maximize revs at fastest part of circuit. 

 

Friction 

¶ Theoretical v experimental test on materials 

¶ Apply to model tires 

¶ Predict outcome 

¶ Run acceleration simulation 

¶ Interpret results 

¶ Inform further design 

 

Design guide: Increase wheel friction, match gearing to track, reduce mass 

 

Homework six - Industrial designer 

The job of product designer is well paid and varied.  If you would like to know more about 
becoming a designer you may be interested in the story of Victoria, one of the Scalextric 
designers.  Her story is in the companion óreaderô document for this project. 

 

Session eight - Presentation preparation 

Outline 

By the end of this session you will have started creating an electronic presentation 
showing how your design developed. 
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To help, you will first be taught how to convert your body mould into a body shell and add it 
to an assembly.  Rendering the finished car will provide one of the images you will need 
for your presentation. 

 

Starter 

Your teacher will ask you questions about the career of product designer and the 
education route to become one. 

 

Task one - CAD modeling the vacuum formed body 

Outline 

Adding features to convert the body mould into a body shell is straightforward and involves 
re-instating the model tree and making changes to the order of features 

 

Task two ï Convert mold to body shell 

Now you will reinstate the last few features 
in the model tree. 

1. In the model tree drag the Insert Here 
flag to the bottom of the model tree. 

The wheel arches will now be visible in the 
model but only through the front half of the 
model. 

  

 

To correct this we need the mirror feature at 
the bottom of the model tree.   

2. In the model tree drag the Mirror 
feature down to just above the Insert 
Here flag. 

Tip: Do not drag the feature too low in the 
model tree.  If you do you will see a No 
Entry icon and the feature will not be 
moved. 
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The model will regenerate, mirroring the 
extra features and you should now have a 
symmetrical car body. 

 

3. Save your model. 

 

 

Task three - Part properties 

While the shape of the body is complete, we still need to record other details to form a 
complete description of the part including a description, the project it forms part of, who 
created it and the material it is made of. 

 

Material properties 

1. From the Pro|ENGINEER main toolbar 
left-click Edit, and, from the pull-down 
menu, select Setupé 

This will open the Pro|ENGINEER Menu-
manager. 

2. Left click Material. 

Pro|ENGINEER will now display the 
Material dialog. 

 

 

3. Navigate through the 
Plastic and 
Polystyrene folders 
then select on eof the 
three materials listed. 

4. Left click  the 
Assign button 

followed by .  

Pro|ENGINEER will now 
apply this material to the 
body mould. 

5. In Menu Manager, 
select Done to finish 
assigning material 
properties. 

 

 

 

For accurate analysis you should find out the exact type of 
vacuum forming material you will be using. 


